ATTENTION!

***Do Not Use***
Substitute Roster button during Intersession
or any other hourly program

See page 56 for directions on printing the correct roster for visiting teachers or any other teacher that cannot access TeacherConnection during Intersession.
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview of Intersession Processes</td>
<td>9</td>
</tr>
<tr>
<td><strong>Part I: Getting Ready</strong></td>
<td>11</td>
</tr>
<tr>
<td>Logging in to Your I-Track</td>
<td>12</td>
</tr>
<tr>
<td>Setting up the Faculty</td>
<td>13</td>
</tr>
<tr>
<td>A. Create faculty status records for teachers who teach in your I-track</td>
<td>13</td>
</tr>
<tr>
<td>Teacher appears to already have a facstat but doesn’t appear in Master Schedule</td>
<td>15</td>
</tr>
<tr>
<td>Adding an Employee to the I-Track</td>
<td>17</td>
</tr>
<tr>
<td>B. Assign Teacher Web permissions</td>
<td>20</td>
</tr>
<tr>
<td>C. Assign Zangle FrontOffice Permissions</td>
<td>25</td>
</tr>
<tr>
<td>Master Schedule</td>
<td>30</td>
</tr>
<tr>
<td>Scheduling Students</td>
<td>34</td>
</tr>
<tr>
<td>A. Mass schedule students</td>
<td>34</td>
</tr>
<tr>
<td>Deleting a Student’s Schedule</td>
<td>37</td>
</tr>
<tr>
<td>Assign Students</td>
<td>37</td>
</tr>
<tr>
<td>B. Individually schedule students</td>
<td>41</td>
</tr>
<tr>
<td>C. Print class rosters, if desired</td>
<td>43</td>
</tr>
<tr>
<td>D. Print student schedules if desired</td>
<td>43</td>
</tr>
<tr>
<td>Making Sure Everyone is Ready</td>
<td>45</td>
</tr>
<tr>
<td>Frequently Asked Questions</td>
<td>46</td>
</tr>
<tr>
<td>A. Setting up the faculty</td>
<td>46</td>
</tr>
<tr>
<td>B. Enrolling students</td>
<td>48</td>
</tr>
<tr>
<td><strong>Part II: Things to do During the Program</strong></td>
<td>51</td>
</tr>
<tr>
<td>Intersession Key Points for Schools</td>
<td>53</td>
</tr>
<tr>
<td>Maintaining Attendance</td>
<td>54</td>
</tr>
<tr>
<td>Collection Status Report</td>
<td>55</td>
</tr>
<tr>
<td>Print attendance rosters for visiting teachers</td>
<td>56</td>
</tr>
<tr>
<td>ENTERING ATTENDANCE</td>
<td>59</td>
</tr>
<tr>
<td>Using Rapid Entry to Post All-Day Attendance</td>
<td>59</td>
</tr>
<tr>
<td>Using Student Attendance History</td>
<td>66</td>
</tr>
<tr>
<td>Using Class Entry</td>
<td>69</td>
</tr>
<tr>
<td>REPORTING TO SPECIAL ED ON DAYS 1 AND 2</td>
<td>71</td>
</tr>
<tr>
<td>Maintaining Enrollment</td>
<td>73</td>
</tr>
</tbody>
</table>
Enrolling Students ................................................................. 74
  A. Enroll students ........................................................................ 74
  B. Determine No Show Students ........................................ 78
  C. Delete No Show Student Records .................................... 79
  D. Withdraw Students as Needed ........................................ 82

Maintaining Schedules and Courses ........................................... 84
  A. Change a student’s schedule, if necessary .................... 84

Changing a Student’s Schedule .............................................. 85
  Assign Students ................................................................. 85
  Student Schedule Editor ...................................................... 90
  B. Change the teacher of a course, if necessary .............. 93

Part III: End of Intersession Tasks ........................................... 97
  End of Intersession Reporting ............................................... 99

Part IV: Appendices .................................................................. 101
  Directions for Teachers ........................................................ 1
    What are my responsibilities? ........................................... 1
    You must........................................................................... 1
  Posting Attendance ............................................................ 2
    How do I post attendance? ................................................ 2
    What if I can’t log in to TeacherConnection to post attendance? ........................................................................... 5
    When do I sign attendance verification reports? .............. 6
  Troubleshooting TeacherConnection Problems ...................... 7
  Class Rosters .......................................................................... 8
  Schedule Listing ...................................................................... 9
This document was created by the San Diego Unified School District’s IT Training Team as reference material for users who will access Zangle at their schools for Intersession.

The handbook is divided into four sections:

1. **Part I** describes how to get ready for Intersession, including building the master schedule, enrolling students, and scheduling students.

2. **Part II** explains the things that need to be done during Intersession, such as how to maintain attendance and drop no-show students.

3. **Part III** describes what to do at the end of Intersession.

4. **Part IV** has a set of reproducible directions for teachers.

**Note:** Screenshots in this handbook will not be updated every year to reflect the current year. Screenshots will only be updated to reflect a change in software or a change in procedure. Anytime a screenshot refers to either an E-Track or U-Track, always substitute I-Track. Also, anytime a screenshot refers to an earlier academic year, substitute the appropriate academic year.

Names used in the documentation are fictitious. Instructions are explained with screenshots and numerical steps. Please follow the steps in numerical order.
Overview of Intersession Processes

BEFORE INTERSESSION BEGINS

- Faculty: Create faculty status records and assign either Zangle or TeacherConnection permissions.
- Master schedule: Build the master schedule.
- Enrollment: Enroll the appropriate students.
- Scheduling: Schedule students for classes and print schedules (if desired).

DURING INTERSESSION

- Teachers post attendance for each period daily using TeacherConnection and sign weekly verification reports. The office enters attendance in Zangle for visiting teachers.
- Enroll, schedule, and drop students as needed.
- Modify student schedules and teachers’ courses as needed.

AFTER INTERSESSION ENDS

- Sites will print and submit the Monthly Hours Attendance report to Pupil Accounting, Ed Center, Room 1008 on the first floor.
- The week after Intersession ends, IT will close all of the student status records in your I-Track.

Throughout Intersession, if you need assistance using Zangle, contact your designated ITSS Support member referenced in the Extended Learning Opportunities Intersession Information Packet.
Part I: Getting Ready
Logging in to Your I-Track

Logging in to the Intersession track is the same as logging in to your school’s regular track. To log into Zangle, you need to enter a username and password. Your username is your district Employee ID, and your password is the same password you use for your district email account. If you do not know your Employee ID, contact your Site Technician, Head Secretary, or other staff member who is responsible for managing time and labor information at your site.

Follow the steps below to log in to the Intersession track.

1. To launch Zangle, first click the Start button. Click Applications and then choose Zangle. A Select a School/Track/DBC window will appear.
2. Choose Production and click Select. A login window will appear.
3. Type your Employee ID in the User Name field. Type your password in the Password field.
4. Click Login (or press Enter). A Select School/Track/Year window will appear.
5. Double-click your I-Track. You will be logged in to your school’s Intersession track.

Note: If someone does not see an I-Track, it is because she does not have a Faculty Status record for this track. See “A. Create faculty status records for teachers who teach in your I-track” on page 13 for more information. If someone can log in to the I-Track but receives a message about not having permissions, it is because she does not have permissions in Zangle for this track. See “C. Assign Zangle FrontOffice Permissions” on page 25 for more information.
Setting up the Faculty

Any faculty that will be using Zangle during Intersession needs to be set up so he or she can access the Intersession track. You will need to do the following:

A. Create faculty status records for the Intersession faculty. Directions begin on this page.


C. Assign Zangle FrontOffice permissions. See page 25.

Follow the steps below to set up your faculty.

A. CREATE FACULTY STATUS RECORDS FOR TEACHERS WHO TEACH IN YOUR I-TRACK

- Launch Zangle. Click System. Click Faculty Info. Click Faculty.

  1. Click the Status tab. This screen displays the faculty’s status records if any exists.

  2. Click Find or List and display the desired faculty’s record.

  3. Click Edit. The screen will change, and the fields will be white, which means they are editable.
Click New.

Verify that the I-Track for the current academic year is chosen. If it is not, choose it from the Track menu.

Check the appropriate boxes for this faculty member.
- **Teacher**: Any faculty whose name needs to be in the master schedule for this track or set up as Alternate Faculty (job share).
- **Site Admin**: A school site administrator (principal, vice principal, etc).
- **Counselor**: A counselor for this track.
- **Certificated**: A certificated employee.

Click Save.
You will return to the previous screen, where you will see the facstat record that you just created.
Repeat Steps 1 – 7 for any other Zangle user that needs a facstat record created for your I-Track.

Click Quit (on that screen) when you are finished.

Enter the date that the person will be able to access this track (not the first day of the job)
Teacher appears to already have a facstat but doesn’t appear in Master Schedule

If a faculty status record seems to have already been created for a faculty member but the teacher’s name doesn’t appear in the Master Schedule, that record might not have the Teacher and Certificated boxes checked, as shown in Step 7 immediately above.

If this is what you see, then follow the steps beginning on the next page.
Click the I-Track status record for the current academic year.

1. Click Edit.

2. Check the Teacher and the Certificated boxes.

3. Click Save.
Adding an Employee to the I-Track

Any teacher (or clerk) who normally does not work at your school will likely need to have a FacStat created in your I-Track. To do this you must log into the SDUSD San Diego Unified School District track.

Follow the steps below to add a new employee to your track

- Launch Zangle and select the district track.

1. The San Diego Unified School Distr track will be at the bottom of the list.
   Note: The number of tracks that you see varies from user to user.

- Click System. Click Faculty Info. Click Faculty.

2. Click Find or List and display the desired faculty member’s record.
Click the Status tab.

3

IMPORTANT!
The faculty member should not have an active facstat record for your I-Track. If he does, stop here and turn to page 15 “Teacher appears to already have a facstat but doesn’t appear in Master Schedule.”

4

Click Edit.
The screen will change.

5

Click New.

6

Set the Entry Date only.
This setting determines the first day that the person can access this track in Zangle.
Note: The date defaults to the system date.

7

Choose the appropriate I-Track.
Be careful with your selection!
Your site will have many tracks in the list. Make sure to choose the I-Track for the current academic year.

8

Check the appropriate boxes for your staff member.

9

Click Save.
The window changes.
If you need to add any more employees to your I-Track, simply turn back to page 17, and repeat this process starting with Step 2.

**IMPORTANT:** When finished adding employees to your I-Track here from the District Track, remember to switch back to your I-Track:

1. Click the **Quit** button above.
2. Close the **Faculty Information** buttons.
3. Close the **System Menu** buttons.
4. From the **File** menu, choose **Switch School/Track/Year**.
5. Select your I-Track.

**IMPORTANT!** The faculty member should now have an active facstat record for your I-Track.
B. ASSIGN TEACHER WEB PERMISSIONS

Teachers need to access student data in Student Profile via TeacherConnection. TeacherConnection allows users to take attendance and submit marks. Student Profile allows users to view student data, like demographic information, attendance history, and contact phone numbers. You will need to use Zangle Web Administrator (https://dwa.sis.sandi.net/zangleconnect/) to assign these users web permissions. In Zangle Web Administrator, permission settings are organized into roles, such as “Teacher” or “Nurse.”

Follow the steps below to assign TeacherConnection permissions.

- Launch Internet Explorer. Navigate to https://dwa.sis.sandi.net/zangleconnect/ to display the following:
Important: Choose your I-Track (Intersession) from the menu.
Click Zangle Web Administrator.
Click **Permissions.**
The Permissions Setup screen will appear.

6

7

Click **Faculty Roles.**

8

Choose a permission role from the Permissions Role menu.
In this example, a faculty member is being given permissions to the **Teacher** role.
Click the name of the desired Unassigned Faculty that needs to be assigned to that role.

Click Add Member.
The name will appear in the Assigned Faculty list on the right side of the screen.
Repeat Steps 9 & 10 to add additional faculty members to selected roles.

Note: If you prefer, instead of adding each teacher individually, you can click Add All Teachers (not shown in the picture) to move all faculty with the Teacher box checked in the Faculty Editor.

To remove a name from the Assigned Faculty, click the X next to the person’s name.

Close the window when you are done.
C. ASSIGN ZANGLE FRONTOFFICE PERMISSIONS

The Power User can control a faculty member’s access to specific Zangle modules using the Permissions application. Permissions are organized into groups called sets. Sets are roughly organized around specific job descriptions. For example, there are sets called Attendance, General Secretary, and Counselor. An employee can belong to more than one set. It is recommended that employees are not given permissions for applications that they do not need. The directions below describe how to add a person to a permission set.

Important! Users who do not use Zangle FrontOffice during Intersession do not need to be added to a permission set in Zangle.

Adjusting permissions in Zangle should be taken seriously. The Power User is the only person on site who should have access to the Permissions application. You can add or remove faculty members from permission sets but should never attempt to edit or create a set. Your work will be lost. Disciplinary actions might result from abuse of this application. Permission adjustments should be reviewed by the site administrator before implementation.

- Open Zangle. Click System. Click Faculty Info. Click Permissions.

[Diagram of Zangle FrontOffice with instructions to click Edit Members and Edit Apps buttons to add faculty members to permission sets.]
Search for the user that you wish to add to this Permission set.
Select the users (one person or many) that you would like to add to this set by clicking the checkbox next to the person’s name.

Click the right arrow to move the person to the Members column.
The member(s) of the permission set appear on the right side of the screen. To remove a faculty member from a permission set, select the name by clicking the checkbox next to the person's name and click the left arrow key.

Click Save.
Note: A user can be added to more than one set. For instance, a clerk can be added to the Attendance/Enrollment Clerk set and the English Learner - only set.
Master Schedule

Another step in preparing for Intersession is to set up the master schedule in Zangle. This entails assigning a course to each teacher. Elementary schools will assign the course as a section that meets four times. Middle schools will assign two courses, each one meeting twice.

Note: Intersession 1 occurs in the Summer, Intersession 2 occurs in the Winter, and Intersession 3 occurs in the Spring.

Follow the steps below to set up the master schedule.

- Launch Zangle. Click Scheduling. Click Master Schedule.

1. Click the Term menu to choose the appropriate term for which you are scheduling.
   - Note: Intersession 1 occurs in the Summer, Intersession 2 in the Winter, and Intersession 3 in the Spring.

2. Click the Faculty menu to choose the teacher for whom you would like to assign a course.
Choose a classroom number from the Classroom menu if known.

The checkboxes for three fields should be marked like those circled in this example.

Click Save.
You will return to the previous screen.

NOTE: This is an example of an elementary school that is configured to offer these courses. Middle schools have different courses.

Select the appropriate course from the Available Courses menu. Click the course, and drag and drop it next to Period 1. A new window will appear.

Make sure Assign Grades and Post to History are not checked. Uncheck if necessary.

Choose a classroom number from the Classroom menu if known.

The checkboxes for three fields should be marked like those circled in this example.
The course and section are listed. Now you need to add segments (additional meetings) of this section.

7. Choose the same course from the Available Courses menu. Click the course, and drag and drop it next to the next available period. A new window will appear.

8. Click the existing section.

9. Click Add Segment. You will return to the previous screen.
The course is listed. Now there are two segments of the same section. Notice that in this example, both segments end in -1.

At an elementary school, a third and fourth segment need to be added. All segments must end in the same number after the hyphen.

At a middle school, each course consists of two segments. Both segments end in the same number after the hyphen.

If you need to schedule courses for other teachers, repeat Steps 1-10 until each Interession teacher has been assigned his or her course.

Click Quit when you are finished.
Scheduling Students

After students are enrolled, schedule them into the appropriate classes. (For further information about Enrollment, please see Maintaining Enrollment on page 73.) Here are the four scheduling tasks:

A. Mass schedule students. Directions begin on this page.

B. Individually schedule students. See page 41.

C. Print and distribute the class rosters, if desired. See page 43.

D. Print student schedules, if desired. See page 43.

Follow the steps below to schedule students for Intersession classes.

A. MASS SCHEDULE STUDENTS

Once you have built the master schedule, you can schedule students into the Intersession classes. To mass schedule students into classes, use the application called Assign Students.

- Launch Zangle. Click Scheduling. Click Assign Students.

Upon opening this application the first faculty on the list is selected by default.

There are no courses scheduled for this faculty member.

Click Find or List to locate a teacher.
Select the course for which you would like to schedule the students. If this says All Courses, you must change it.

Select the date that the students will start the class.

If desired, select the grade level to filter the list of students.

If desired, choose Show students with NO schedules to filter the list of students.

Note: To schedule Middle School students for their second class, you don’t want to choose Show students with NO schedules.

Click each student that you want to assign to this class. The selected names will be highlighted green. Make sure the entire line turns green, as shown here.

Click the right arrow to schedule the selected students. A new window will appear.
Choose Manually Scheduled from the menu.

**Click Start Scheduling.**

After the names are processed, you will return to the previous screen.

The students are scheduled for the course. Their names are highlighted purple because they are scheduled.

Repeat Steps 1-9 as necessary. Click Quit when you are finished.

**IMPORTANT!** The total number of students along with gender breakdowns appears here.

**IMPORTANT!** Make sure that the date is correct. If it is not correct, click CANCEL Scheduling NOW! and adjust the date on the previous screen (see Step 3).
Deleting a Student’s Schedule

At times, you might mistakenly schedule a student for a class and thus want to delete his or her schedule. These directions describe how to remove a student from a class so there is no record that he or she was ever scheduled for it. Use these directions only if you are fixing an error and the student never attended the class, not even for one period.

Follow the steps below to delete a student’s schedule.

Assign Students

- Launch Zangle. Click Scheduling. Click Assign Students.

1. Upon opening this application the first faculty who has access to your track is selected by default.

This message appears when the selected faculty has no courses in the master schedule.

There are no courses scheduled for this faculty member.

Click Find or List to locate the desired teacher. This should be the teacher for whom you want to unschedule the student.
Verify that this is the course for which you would like to unschedule the student.

3. Select the date that you want to delete the schedule. This must be the same date as the one used to originally schedule the student. If you do not know the date, use Change History to look up the student’s scheduling date.

4. Click the student that you want to unschedule from the class. You can select one name or multiple names. The selected name(s) will be highlighted green.

5. Click the single left arrow to unschedule the selected students. A new window will appear.
6. Choose Schedule Change from the Exit Code menu.

7. Click Start Unscheduling. Because you selected an exit date that matches the entry date, a new window will appear.

The Unschedule Date (01/31/2005) is on or before the Entry Date (01/31/2005)

8. Click DELETE the schedule. You are deleting the schedule because you do not want any record of the student being in this class.

9. Click Don’t delete schedule if attendance records exist. In this case, there will not be any attendance records anyhow.

10. If you selected multiple students in Step 4, choose Apply to all selected Students for this Course. Click Proceed. You will return to the main screen.
11 Verify that the student is removed from the class.
- Look on the right side of the screen to see that the student is no longer on the class roster.
- Look on the left side of the screen using the Show Students with NO Schedules filter to verify that the student has no schedule.

12 Click Quit.
B. INDIVIDUALLY SCHEDULE STUDENTS

You can schedule students one-by-one into their Intersession classes. To individually schedule students into classes, use the application called **Student Schedule Editor**.

- Launch Zangle. Click Scheduling. Click Student Schedule.

![Student Schedule Editor - Carson Elementary](image)

1. Click Find to find the desired student.

   **Important**: You will need to pick the student's I-Track record.

2. Enter the date that the student will start the class.

3. Click Term.

4. Double-click in the appropriate cell for the session for which you are scheduling. A new window will open. (In this example, the user is scheduling the student for Intersession 2.)

   **Note**: You can also click once in the cell and then click Sched (at the bottom of the screen).
5. Check the desired section.

6. Click Save & Done. You will return to the previous screen.

7. IMPORTANT! Click Save. When you are done, click Quit.

The student’s schedule appears. If you set up the course with segments in the master schedule, the schedule automatically fills in all the appropriate periods for you.
C. PRINT CLASS ROSTERS, IF DESIRED
1. To print class rosters, follow the steps below. A sample class roster is shown on page 8 of “Directions for Teachers” at the end of this document.

2. Launch **Zangle**. Click **Scheduling**, click **Reports**, and then select **Class Rosters**.

3. Enter the first day of Intersession as the effective date on the **Options** tab.

4. Click the **Select** tab.

5. Double-click the **Track** field. Select the Intersession track and then click **Done**.

6. If you want to select a particular teacher, double-click the **Faculty** field. Select the teacher and then click **Done**. Otherwise, skip this step, and class rosters for all teachers will be printed.

7. Click **Preview** to preview the rosters. A new window will open.

8. Read the cover page. Then click the **X** to close it. The rosters are “underneath” it.

9. Preview the rosters. Then click the **X** to close the report. A **Select Report Destination** dialog box will appear.

10. Click **Continue** to print. Otherwise, click **Cancel**. If you print the rosters, you probably want to uncheck the **Cover Page** option.

D. PRINT STUDENT SCHEDULES IF DESIRED
It is recommended that you use the **Schedule listing** to print students’ Intersession schedules. This will show their Intersession schedules only. (If you want to print the students’ entire full day schedule, you will need to use the **Locator Report**. The directions are not included here.) To print students’ Intersession schedules, follow the steps below. A sample student schedule is shown on page 9 of the Directions for Teachers later in this document.

1. Launch **Zangle**. Click **Scheduling**, click **Reports**, and then click **Schedule Listing**.

2. Enter the first day of Intersession as the effective date on the **Options** tab.

3. Under **Include Schedule Terms**, uncheck **All** and then click the desired term.

4. Click the **Select** tab.

5. Double-click **Student Group**.

6. Double-click **InterScheds**. (You have just filtered your report to print the schedules only for any student scheduled for an Intersession class.)

7. Click **Preview** to preview the schedules. The cover page opens.
8. After reading the cover page, click the X to close it. The first student’s schedule appears.

9. Preview the schedules. Each student’s schedule is a report. Instead of closing the report page for each individual student, press and hold the Escape key on your keyboard. Click Yes when asked if you want to cancel the report.

10. To print, click Print.
Making Sure Everyone is Ready

Prior to the beginning of Intersession, ensure that everyone knows what they will need to do.

ENROLLMENT CLERK
The enrollment clerk should review the applicable pages of this handbook prior to beginning Intersession. He or she should also have the most recent version of the Enrollment Handbook and should be familiar with the Zangle enrollment applications and reports.

- Does the enrollment clerk have access to the Intersession track?
- Can he or she log in?
- Does he or she know how to enroll students into the Intersession track?
- Does he or she know how to enroll students into other schools’ Intersession tracks?
- Does he or she know how to withdraw students?

ATTENDANCE CLERK
The attendance clerk should review the applicable pages of this handbook prior to beginning Intersession. He or she should also have the most recent version of the Attendance Handbook and should be familiar with the Zangle attendance applications and reports.

- Does the attendance clerk have access to the Intersession track?
- Can he or she log in?
- Does he or she know how to maintain attendance for Intersession?
- Does he or she know how to print Intersession attendance rosters for visiting teachers? (It’s different from the way it’s done in the S-Track.)
- Does he or she know how to enter attendance for visiting teachers?

TEACHERS
A set of directions has been developed for teachers. It is designed to walk teachers through the process of logging in and taking attendance. Copy and distribute the directions. These directions can be found at the end of this document.

- Do the appropriate teachers have access to the Intersession track?
- Can they log in to TeacherConnection?
- Do they know how to take attendance? (Intersession is Positive Attendance.)

STUDENTS
- Do the students know their Intersession schedule?
Frequently Asked Questions

A. SETTING UP THE FACULTY

The questions below address how to handle various situations that you may encounter as you set up your faculty for Intersession.

1. How do I set up a job share?

A job share allows two faculty members to post attendance and submit marks for the same class in TeacherConnection. Use the Alternate Faculty Editor to create a job share. This application can be used to provide long-term substitute teachers with access to student information as well.

1. First, identify one teacher as the main (or “Assigned”) faculty member for the class, and use the Master Schedule application to assign a section to that person.
2. Then, click System, click Faculty Info, and click Alt Faculty.
3. At the top of the screen, choose either “Job Share w/out Marks” or “Job Share w/Marks.”
   Note: If the alternate faculty needs to submit marks, make sure to choose “Job Share w/Marks.”
4. At the bottom of the screen click Add. A new window will appear.
5. Enter the date range for the job share.
6. Choose the Assigned Faculty, the staff member who is currently scheduled for the class you wish to share. The sections for which he or she is scheduled will appear.
7. Choose the Alternate Faculty, the second staff member who will share the class.
8. Place a check next to the class that you want to share with the second staff member.
9. Click Save. The two faculty members will have access to the same class.

For full directions with screenshots, please refer to the System Administration for Power Users Handbook.

2. Why can’t one of my teachers log in to the Intersession track?

There are various reasons why a teacher might not be able to log in to the Intersession track. First check that his or her faculty status record is set up correctly.

1. Click System, click Faculty Info, and then click Faculty.
2. Find the teacher and click the Status tab.
3. Verify that there is an open facstat record for the Intersession track, one with a beginning date but not an ending date. If there is not, create one for the teacher. See page 13 for directions. Is the Teacher box checked? If not, then check it.

If the facstat record appears to be set up correctly, check the Master Schedule next. Make sure that the teacher has been assigned a section. See page 30 for directions.
It might be that the teacher is not logging in correctly: using the wrong password, not choosing the correct track, and so on. To troubleshoot further, ask the teacher to show you how he or she is attempting to log in.

3. A teacher from another school is going to teach Intersession at my school. How do I give her access to my track?

Create a faculty status record for the teacher as described earlier, starting on page 17.
B. ENROLLING STUDENTS

The questions below address how to handle various situations that you may encounter as you enroll students for Intersession.

1. How do I make a student “Primary site of multiple sites” instead of “Active?”

To change a student’s status from Active to Primary site of multiple sites, you need to edit the student’s status record:

1. Click Enrollment and then click Student Editor.
2. Find the student.
3. Click Edit. The screen will turn white.
4. Double-click the status record that is labeled Active. A new window will open.
5. In the Status drop-down menu, choose Primary site of multiple sites.
6. Click Save. You will return to the main screen.
7. Click Done. The screen will turn grey, and the student’s status should read, Primary site of multiple sites.

2. How do I enroll another school’s student into my Intersession track?

You cannot enroll another school’s student into your Intersession track. Call your designated ITSS Support member referenced in the Extended Learning Opportunities Intersession Information Packet.

3. How do I enroll a student from my school into another school’s Intersession track?

If someone asks you to enroll your student into another school’s Intersession track, refer to the enrollment directions that begin on page 74. Do everything the same except for Step 4, where you need to choose the other school and its Intersession track.

4. Zangle will not let me drop a student that is enrolled part-time at another school. What do I do?

You cannot drop a student who has an open status record at another school. You will need to ask the clerk at the part-time school to drop the student first. Only then can you drop the student from your school.

5. Can I run reports on just my Intersession students?

You can generate Zangle reports for your Intersession students. For most reports you will need to click the Select tab and then choose the Intersession track after opening the Track selection.
Because all of your S-Track students are enrolled in your I-Track, you'll also want to filter your reports by the InterScheds group, just those students who are scheduled for a class in your I-Track. Click the Select tab; double-click Group; scroll down and select InterScheds.

If you are running a Query Writer report, you will need to drag Track into the Filter area at the bottom of the screen. Filter the report by “Track code begins with I.”

6. Why do I see the Intersession students in the regular track?

Zangle looks at the student for the whole day. Therefore, in the regular track you have the ability to see Intersession information for the student without having to change tracks.

7. Do I need to close my students from the I-Track when Intersession ends?

No, the IT Department will close all of the students’ status records in your I-Track for you the week after each Intersession ends.
Part II: Things to do During the Program
ATTENTION!

***Do Not Use***
Substitute Roster button during Intersession
or any other hourly program

See page 56 for directions on printing the correct roster for visiting teachers or any other teacher that cannot access TeacherConnection during Intersession.
Intersession Key Points for Schools

1. _____ TEACHERS: The teachers must take attendance four times per day (once each hour) electronically using TeacherConnection. This includes your long-term visiting teachers. Make sure they know it is positive attendance and they need to mark students Present.

2. _____ ATTENDANCE CODES: The whole school should only use Present and Unverified Absence as attendance codes. Do not mark students Tardy or any other code.

3. _____ DO NOT USE THE SUBSTITUTE ROSTER. Only use the Teacher’s Summary of Attendance report as your attendance roster.

4. _____ COLLECTION STATUS REPORT: You need to run the Collection Status Report every hour. Someone needs to contact the teachers who are not taking attendance because all attendance needs to be posted by the end of the day. NOTE: It does not need to be printed.

5. _____ CLASS ENTRY: If you have day-to-day visiting teachers who take attendance on paper, the office must enter the attendance. You can use any method you want; however, you must go to Class Entry and check that attendance was taken in order to clear the section from the Collection Status Report.

6. _____ DAY 1-2 REPORT FOR SPED STUDENTS: You must run a Day 1-2 report for SPED students. It is in Scheduling Query Writer. You must check that the Collection Status Report is clear before running these reports. You need to fax it to Special Education (619-725-7246) by the end of your instructional day.

7. _____ MONTHLY HOURS ATTENDANCE: At the end of Intersession, you must print the Monthly Hours Attendance report twice, once for Special Ed students and once for Regular Ed Students, and submit to Pupil Accounting, Ed Center, Room 1008 on the first floor.
Maintaining Attendance

Intersession is positive attendance. This means that all students are marked Absent by default. Teachers are expected to use TeacherConnection to post attendance for all four periods. The URL for Intersession TeacherConnection is https://dwa.sis.sandi.net/zangleconnect/.

The office staff is expected to complete the following attendance tasks:

- **Enter attendance for any teacher that cannot access TeacherConnection.** Teachers that cannot access TeacherConnection will take attendance on paper and submit their rosters to you during Period 4. There are three methods for entering attendance. Each is discussed on the following pages. Please do not mark students Tardy or clear absences. Students should be marked either Present (.) or Unverified Absence (A) only! For each day that you enter attendance, make sure that you initial the roster.

- **Report to Special Education on Day 1 and 2.** On the first and second day of Intersession, you must report the total number of Special Ed students that were Present. To do this each day, you will print a query stored in the Scheduling module and then each day fax the report to Special Education by the end of your instructional day.

- **Print and distribute weekly attendance rosters for teachers that cannot access TeacherConnection.** Use the Teachers Summary of Attendance report.

- **Collect signed Teacher Summary of Attendance reports.** Collect paper rosters from teachers that cannot access TeacherConnection.

- **Collection Status Report.** Run the Collection Status report each period to ensure that all teachers have posted attendance for each day. It is not necessary to print it.
COLLECTION STATUS REPORT

To determine which teachers have not posted attendance, generate a Collection Status Report and review it. You do not need to print the report.

It is suggested that you review this report at intervals throughout the day, so you can see which teachers failed to post before the end of the day and then ask them to post. If necessary, give a copy of the report to the appropriate administrator at your site to follow-up with teachers who are not taking attendance.

The goal is to see a blank Collection Status Report with no names on it. The bottom of the cover page will read, "NO SECTIONS SELECTED FOR REPORT." Please make sure this is done before generating the report described on page 71.

Follow the steps below to determine which teachers have not posted attendance.

- Open Zangle. Click Attendance. Click Reports. Select Collection Status.

To review this report at intervals throughout the day, click the Select tab. Double-click Track Period. Select the desired period(s) from the list and then click Done.

When you preview the report in Step 3, you will see who did not post for the period(s) you selected.

Click Preview.
Close the cover sheet and preview the report.
After previewing the report, click the outer X in the upper right-hand corner of the screen. You will see a destination window. Click Continue if you want to print. Click Cancel if you don’t.
PRINT ATTENDANCE ROSTERS FOR VISITING TEACHERS

Substitute teachers will take attendance using paper class rosters. You will need to print these paper rosters so they are available for visiting teachers as they check in. Print one-week, multi-period, positive attendance rosters via the Teachers Summary of Attendance report. (Important: This is a different roster from the one used in the S-Track.) Visiting teachers should be told to sign their rosters before returning them to the office.

Follow the steps below to print one-week substitute rosters.

- Launch Zangle. Click Attendance. Click Reports. Select Teachers Summary of Attendance.

1. Click Week. Verify that the Start and End dates include the correct dates.

2. Check Print Certification Line and uncheck Print Landscape Report.

3. Click Preview to preview the report. You will see progress bars, and then a window will open.
STEPS FOR OPTIONALLY PICKING INDIVIDUAL TEACHERS

Double-click Faculty.

Select the teacher that requires a paper roster and click to move that name to the right side of the window. Repeat this process for any other teacher that requires a paper roster. Rosters will print for only the teachers that appear on the right side of this window.

Click Done and proceed with Step 3 on the preceding page.
4. Read the cover page. Then click the X to close it. The report is underneath it.

5. Preview the report. Then click the X to close the report. A Select Report Destination dialog box will appear.

6. Click Continue to print. Otherwise, click Cancel.

The teacher’s name and class appears at the top of the roster.

Each student is listed once, with A-codes for each period.

The roster should display only a one-week range. If it does not, cancel the report and repeat Step 1.

If you print the report, you may want to uncheck the Cover Page option.
ENTERING ATTENDANCE

For any teacher that took attendance on paper, you will need to enter the attendance using Zangle. You can use Rapid Entry, Student Attendance History, or Class Entry; however, you must mark Attendance Taken in Class Entry even if you use Rapid Entry or Student Attendance History to enter attendance. For this reason, most users opt to use the Class Entry method, starting on page 69. Mark students with only two codes: Present or Unverified Absence. Because Intersession is positive attendance, all students are marked Absent by default.

Using Rapid Entry to Post All-Day Attendance

You can only use Rapid Entry to post all-day attendance for students. This means that students must have four X's next to their names in order to use this method. For any student that was Present for part of the day, use Student History instead.

Follow the steps below to use Rapid Entry to post all-day attendance.

• Launch Zangle. Click Attendance. Click Rapid Entry.

1. Click the Class tab.
1. Make sure the date is set to the day for which you are posting attendance.
2. Select Present (signified by a dot) from the Code menu.
3. Find the appropriate teacher’s course. There will be multiple periods listed. Click the box next to Period 1.
4. Click Teacher (at the top of the column) to sort by teacher.
5. Click Select a Period Range.
6. Click Continue.
7. A pop-up window will appear.
8. Click Continue. The class roster for the selected course will appear.
The checked box signifies that the student was Present all day. All students are checked by default.

This is the class roster for the course selected in Step 5.

Uncheck the box next to any student that was not Present all day (Periods 1-4). This includes unchecking students that were Present for only part of the day. Use Student History to post attendance for those students.

Click Save. A verification message will appear.
Click Yes.

Note: The attendance has not been posted yet. It has been saved for review.

The students that were not present all day remain untouched.

Click Done.
You will return to the main screen with the list of teachers and courses.
If you have more attendance to enter for other classes, repeat Steps 5-12.
Once all attendance has been entered and saved, click **Review**.
A progress bar will appear. Then you will see a list of the students that you left checked.

13

Verify the list of students. Any student with a check will have his/her attendance posted as Present for all periods for the course(s) you selected.
If you need to uncheck a student because he or she was not Present all day, you can do that now.

14

Click **Post**.
A verification message will appear.

15
Click Yes. A progress bar will appear, followed by a log report.

16. Review the log report, and then click the X to close it.

17. Click Yes, unless you don’t want to print the report.

18. Students for whom attendance will be posted all day have a “1” next to their names (in the Action column). There is a key at the bottom of the report that describes other actions.
Important: To ensure the accuracy of the report faxed to the Special Education Office on days one and two (see page 71), you want to now open Class Entry (see page 69) and indicate that attendance was taken for these teachers for all four periods of the day.

19. Click OK.

This message describes the number of attendance records added, updated, or not allowed. 

NOTE: Since each student is being marked Present four times, the number of records added will be four times the number of students selected.

20. Click Quit.

The pending attendance is now empty because the attendance was posted. You can check to see that the attendance was posted to all four periods by looking up a student in Student Attendance History.
Using Student Attendance History

Use Student History to enter an individual student’s attendance. It is recommended that you use this application in conjunction with Rapid Entry, where Rapid Entry is used for students that are Present all day, and Student History is used for students that are Present only part of the day. However, you can use Student Attendance History for all-day attendance if desired.

**Note:** For more information on using Student Attendance History, please refer to the Zangle Attendance Handbook.

Follow the steps below to use Student Attendance History to post attendance.

1. **Launch Zangle.** Click Attendance. Click Student History.

   - Click Find or List and display the desired student’s record.
   - Click Edit.

   The window displays dates for which the student is scheduled. Notice that each student is marked absent by default for any date that doesn’t have attendance yet posted.

   If the window displays, **No Schedule Records**, then the student is not scheduled for any classes for this track.
Right-click in a cell to display a list of attendance codes.

4. Click the desired code, Present.

5. Click either Set Period 1 to End of Day or Set Period 1 Only.
Important: To ensure the accuracy of the report faxed to the Special Education Office on days one and two (see page 71), you want to now open Class Entry (see page 69) and indicate that attendance was taken for these teachers for all four periods of the day.

Click Save. If you need to enter attendance for other students, repeat Steps1-5.
When you are finished, click Quit.
Using Class Entry

When you use Class Entry to enter attendance, you will need to enter attendance for each of the four periods per teacher, executing Steps 1 through 6 four times.

**Important:** If you entered attendance via Rapid Entry or Student History, it’s important to pull up those teachers (Step 1, immediately below), and click the Attendance Taken box for all four periods (Step 2). There is no need to do Step 5 because the Attendance posted via Rapid Entry will appear.

**Note:** For more detailed information on using Class Entry, please refer to the Attendance Handbook.

Follow the steps below to use Class Entry to post attendance.

- Open Zangle. Click Attendance. Click Class Entry.

![Class Entry - Carson Elementary](image)

1. Select a period.
2. Click Edit.
3. Verify that the date is that for which the attendance is being taken. If necessary, change the date.

If you entered attendance via Rapid Entry (page 59), click Attendance Taken after clicking the Edit button (Step 3) and then click Save.
Click the Present radio button.

4

Click each student’s name to mark him present. The A changes to a . (period). If you mark a student Present by mistake, simply click the Unverified Absence radio button and then click the student’s name again. The . (period) changes back to an A.

If all students are absent, click Attendance Taken.

5

Click Save.

6

Repeat Steps 2 - 6 until attendance for all periods have been posted. When finished, click Quit.

Click the Present radio button.
REPORTING TO SPECIAL ED ON DAYS 1 AND 2

On the first and second day of Intersession, you must report the total number of special education students that were actually present in each class. To do this, each day you will print a query stored in the Scheduling module and then each day fax the report to Special Education by the end of your Instructional day: 619-725-7246.

Follow the steps below to report to Special Ed on Days 1 and 2.

1. Launch Zangle. Click Scheduling. Click Reports. Select Query Writer.

2. Click Display. A report will open.
After reviewing this report to confirm that the information is correct, click the X to close it. You will return to the previous window.

Click Print.

1. After you print the report, sign and date it at the bottom of the report. Have the principal sign and date at the bottom of the report as well.

2. Fax the completed report to Special Ed by the end of your instructional day: 619-725-7246.

Note: On day 2, simply repeat the process to print it. Fax the signed report to Special Ed by the end of your instructional day.

Important: If you need to reprint the report for a previous day, before printing, remember to change the System Date to that previous date.
Maintaining Enrollment

A. Enroll students as needed. Directions begin on the next page.

B. Determine no-show students. See page 78.

C. Delete no-show student records. See page 79.

D. Withdraw students as needed. See page 82.
Enrolling Students

When you first gain access to your Intersession I-Track, you should see students already enrolled. The IT department enrolled students into your I-Track from the list of students received from the Special Education Department. You do not need to create status records for these students for Intersession because they already exist. If for some reason a student is missing, follow the steps below to enroll the student into the I-Track.

*Follow the steps below to enroll students in the Intersession track.*

A. ENROLL STUDENTS

Any student who will attend Intersession needs to be dual enrolled with part-time status in the Intersession track. This portion of the handbook assumes that you are enrolling students who have already been enrolled in a school’s regular day track. For complete directions on how to enroll students, please refer to the Zangle Enrollment Handbook.

- Open Zangle. Click Enrollment. Click Student Editor.
In this area you are completing a district-wide search.

Note: If the student is not found during the initial search, search for the student using fewer or different criteria.

Enter part of the student's last name and first name.

Click Find. A new dialog box opens.
Once you find and select the student, click **Enroll Selected Student**.
A message appears.

4

**Important!** The student’s status (Sts) must be Primary site of multiple sites (M) in order to enroll the student in a part time track. If the status is Active (A), then Zangle won’t allow any more enrollments for this student.

To change the Enrollment Status to Primary site of multiple sites, click **Cancel**.
Pull up the student’s information via the **Find** or **List** button in Student Editor.
Click the **Edit** button, and then double-click the status record that appears as **Active** under the **Status** column. Change the Status from **Active** to **Primary site of multiple sites** and click **Save**. Click **Save**.

5

**Click Yes.**
Enter the following information:
- School (Choose your school. If the student will attend another school’s Intersession track, then select that school.)
- Track (The Intersession track)
- Status (Part-time)
- Entry Date
- Entry Code (Dual Enrollment-02)

TIP! For rapid entry, use the keyboard only:
- School: Quickly type the first three or four letters of the hosting school name. Press tab.
- Track: Type “I.” Press tab.
- Status: Type “P.” Press tab.
- Entry Date: This defaults to the system date. Change it to the first day the child is expected to attend Intersession. Press tab.
- Entry Code: Type “D.” Press Alt+S.

Click Save.

Note: If the student is enrolled in two tracks that are both at your school, then you will see two records for that student in all banner applications.

Click Quit.

You should see the status record that you just created. The student is dual enrolled, with Part-time status in the Intersession track.

Note: If a different student’s record is displayed, click Find or List to pull up the student’s record.
B. DETERMINE NO SHOW STUDENTS

A no-show student is one who does not attend any (or part of any) Intersession class at all. Some schools say that a student who does not attend Intersession on the first day is a no-show student. Others give students the first few days or a week before classifying them as no-shows.

If your school determines no-show students as those who did not attend the first day of class, run the Master Absence List as of the first day of the session. This report is in the Attendance module. Make sure that the I-Track is selected on the Options tab. This report will list any student who was marked Absent for the first day of class.

If your school determines no-show students as those who did not attend the first few days, run the Teacher’s Summary of Attendance report for the date range of your choice. This report is in the Attendance module. Make sure that the I-Track is selected on the Options tab. This report will produce a spreadsheet-view of a teacher’s sections. Any student with all As is a no-show student.
C. DELETE NO SHOW STUDENT RECORDS

Once you have determined your no-show students, delete their Intersession records using Student Editor.

- Open Zangle. Click Enrollment. Click Student Editor.

1. Click Find or List to locate the desired student.

2. Select the I-Track record and note the Entry Date.


4. Enter the following information:
   - Exit Date: The same date as the Entry date you noted above.
   - Exit Code: No Show-Enrollment Dropped.

5. Click Save. You will return to the previous screen.
Notice that the Intersession record is now closed. Next, you need to delete the record.

6. Click Edit. The screen will turn white.

Click Delete. A message will appear.

Click Yes. You return to the previous screen where the Extended Day record has been deleted.

Click Done.
D. WITHDRAW STUDENTS AS NEEDED

To withdraw students from the Intersession track, use **Student Editor**. For complete directions on how to withdraw students, please refer to the Zangle Enrollment Handbook.

- Open Zangle. Click Enrollment. Click **Student Editor**.

1. Click **Find** or **List** to locate the desired student.

2. In this example, the student needs to be withdrawn from the Intersession track. Click **Status**. A new window will appear.

3. Click the track from which the student needs to be withdrawn. The row should be highlighted grey.

4. Enter the following information:
   - **Exit Date**: The last day of student attendance.
   - **Exit Code**: SS/Intersess/Ext Day/Ocile.

   Tip! Before Step 1, set the System Date (at the top of the screen) to the Exit Date. Since the exit date defaults to the system date, you will not have to enter it. Don’t forget to change the date back when you are done!

5. Click **Save**. You will return to the main screen.
The part-time status record is closed because there is an exit date. The student is withdrawn from the Intersession track.

Note: You cannot withdraw a student from the primary site until the part-time status record is closed.

Click Quit.
Maintaining Schedules and Courses

Make sure that the master schedule and student’s schedules are up to date. You might need to do any of the following:

A. Change a student’s schedule, if necessary. Directions begin on this page.
B. Change the teacher of a course, if necessary. See page 93.

Follow the steps below to maintain schedules and courses.

A. CHANGE A STUDENT’S SCHEDULE, IF NECESSARY
To change a student’s schedule, use the Student Schedule Editor or Assign Students.
The directions for using Assign Students appear on the next page. The directions for using Student Schedule Editor appear after that.
Changing a Student’s Schedule

These directions describe how to change a student’s schedule from one class to another. This involves first unscheduling the student from the current class, then rescheduling the student for a different class.

Follow the steps below to change a student’s schedule.

Assign Students

- Launch Zangle. Click Scheduling. Click Assign Students.

Upon opening this application the first faculty who has access to your track is selected by default.

This message appears when the selected faculty has no courses in the master schedule.

There are no courses scheduled for this faculty member.

Click Find or List to locate the desired teacher. This should be the teacher for whom you want to unschedule the student.
Verify that this is the course for which you would like to unschedule the student.

**IMPORTANT!** Select the date that is the last day that the student will be in this class. For instance, if the student’s last day in the class is Friday and will enter the new class on Monday, use Friday’s date.

3. Click the student that you want to unschedule from the class. You can select one or multiple name(s). The selected name(s) will be highlighted green.

4. It is not necessary to change the filter by Show students with NO schedules and/or grade level. However, you may find it convenient to do this.

5. Click the single left arrow to unschedule the selected students. A new window will appear.
Choose Schedule Change from the Exit Code: menu.

Click Start Unscheduling. You will return to the previous screen.

IMPORTANT! Make sure that the date is correct. If it is not correct, click CANCEL Unscheduling NOW! and adjust the date on the previous screen (see Step 3).

You might expect the student’s name to be missing from the roster because you just unscheduled the student. However, the student will still appear on the roster (blue/purple) because he or she is still scheduled as of the date in the center of the screen. Once you change the date to a future date, the student’s name will appear grey, meaning he or she is no longer currently scheduled in the class.

Click Find or List to locate the desired teacher. This should be the teacher for whom you want to reschedule the student.
Verify that this is the course for which you would like to schedule the student.

**IMPORTANT!** Select the date that is the first day that the student will be in this class.
For instance, if the student’s last day in the previous class is Friday and will enter the new class on Monday, use Monday’s date.

Click the student that you want to assign to this teacher. You can select one name or multiple names. The selected name(s) will be highlighted green.

Click the right arrow to schedule the selected students. A new window will appear.
Choose Manually Scheduled from the Entry Code: menu.

Click Start Scheduling.
After the student(s) is processed, you will return to the previous screen.

IMPORTANT! Make sure that the date is correct. If it is not correct, click CANCEL Scheduling NOW! and adjust the date on the previous screen (see Step 10).

The student(s) selected in Step 11 will appear on the class roster.

Click Quit.
Student Schedule Editor

In the example below, the student needs to be dropped from Cheryl Geck’s section of EDRP Literacy and into Amy Guetz’s section instead.

- Open Zangle. Click on Scheduling. Click Student Schedule.

1. Click Find to locate the desired student.

2. Click Term. The course information is displayed in the upper-left portion of the screen after you complete Step 3.

3. Click the course to select it. A black triangle will appear to the left of the course name.

4. Change the date to the last day that the student will be in the current class.

In this example, the student’s last day in Cheryl Geck’s class (9015-1) is 11/3/03.
Click **Unscd** to unschedule the student. A window will appear.

Verify that this is the **LAST** day that the student will be marked Present in this course. This is the date you selected in Step 4.

Choose **Schedule Change** from the menu.

Click **Start Unscheduling**. This window will close and you will return to the main screen. You will not see the change in the student’s schedule until you complete Step 9.

The student has no schedule once you change the date forward in time (Step 9).

In this example, the student’s first day in Amy Guetz’s class (9015-2) is 11/4/03.

Change the date to the date that the student will begin the new class. Typically this is the next school day.
Double-click in the blank space to schedule the student. (Or click once and then click Sched at the bottom of the screen.) A Section Scheduler window will appear.

Verify that this is the correct entry date. This is the date that you selected in Step 9.

Click the checkbox next to the course you would like to schedule the student into.

The last column lists the number of available seats for that course.

Click Save & Done. You will return to the main screen.

The student's new course is listed. The course information appears in the upper-left portion of the screen.
B. CHANGE THE TEACHER OF A COURSE, IF NECESSARY

At times, you might need to change the teacher of a course. For example:

- Teacher A goes on leave. Teacher B takes over the class.
- You were using a dummy teacher in the master schedule, e.g., “ZZTeacherC,” and now you know who the teacher is.

In both of these examples, the students in the section remain the same. Only the faculty teaching the course needs to change. To change the teacher of a section, follow the directions below.

- Open Zangle. Click Scheduling. Click Master Schedule.

**Diagram Description:**

1. Choose the teacher who needs to be replaced.
2. Click the section. (Any period will do.)
   - A black triangle will appear next to the selected period.
3. Click Edit.
   - A new window will appear.

Remember to choose the appropriate term.
Choose the replacement teacher’s name from the Faculty menu.

Choose the replacement teacher’s name from the Faculty menu.

4

Click Save.

6

If necessary, change the classroom number.

If necessary, change the classroom number.

5

Click Save.

6

If you do change the Classroom number above, this window appears. Click Modify all segments and then click Proceed.

If you do change the Classroom number above, this window appears. Click Modify all segments and then click Proceed.

5

Modify only this segment

Modify all segments

Modify only values in other segments that match this segment’s original values

Proceed Cancel

6
The section is no longer listed under the original teacher’s name. If you select the replacement teacher from the faculty list, the section will be assigned to that person.

Click Quit.
Part III:
End of Intersession Tasks
End of Intersession Reporting

At the end of Intersession, run the Monthly Hours Attendance report twice, once for Special Ed students and once for Regular Ed Students. It is located in the Attendance module. The signatures of both the clerk and principal are required. There is no signature line; sign at the bottom of the last page. Send the originals with the cover pages to Pupil Accounting at the Ed Center, Room 1008 on the first floor. Keep a copy for your records.

Note: Sites that only have Special Ed students during Intersession need only run one report.

Follow the steps below to print the Monthly Hours Attendance report for Intersession.

- Open Zangle. Log into the I-Track.
- Click Attendance. Click Reports. Select Monthly Hours Attendance.
- Prior to completing the steps outlined below, change the titles of the reports as follows:
  - Monthly Hours Attendance – REGULAR
  - Monthly Hours Attendance – SPECIAL ED

1. Verify that the I-Track is selected.
2. Verify that Periods 1 to 4 are selected.
3. Click the Custom radio button.
   - In the From Date field, enter the first day of Intersession.
   - In the To Date field, enter the last day of Intersession.
4. Set the Maximum Hours Per Week to 20.0.
   - Make sure that the Totals Only checkbox is checked.
   - Make sure that the Use All checkbox is not checked.
5. Select Regular or Special Education from the list of attendance categories to match the title of your report in Step 5, above.
6. Click Preview.
   - After a few minutes, a new window will open.
The Intersession students are listed by grade level.

Read the cover page. Then click the X to close it. The report is “underneath” it.

Preview the report. Then click the X to close the report. A Select Report Destination dialog box will appear.

Use the arrow to go to the next page.

The Hours Present column lists the number of hours each student attended Intersession.

The last page of the report displays a statistical summary. The attendance staff and the principal need to sign and date the last page of the report.

Click Continue to print. Otherwise, click Cancel.

DISTRICT WIDE APPLICATIONS
HTTP://WWW.SANDI.NET/DWA
Part IV:
Appendices
Directions for Teachers

Welcome to Intersession! This document has information about Intersession and your responsibilities. If you have any questions about what you are supposed to do, please contact the Zangle Power User at your school.

What are my responsibilities?

<table>
<thead>
<tr>
<th>If you teach Grades...</th>
<th>You must...</th>
</tr>
</thead>
<tbody>
<tr>
<td>K-8</td>
<td>Post daily attendance for every period per day using TeacherConnection. Use the Intersession Track.</td>
</tr>
<tr>
<td>K-8</td>
<td>Sign and return weekly attendance verification sheets distributed by the office.</td>
</tr>
</tbody>
</table>
Posting Attendance

You must use TeacherConnection to post attendance for each period. This must be done each school day by the end of the day. You cannot go back in time to enter attendance. You will be able to mark your students Present or Absent. The default attendance code for each student is Absent.

Posting attendance for Intersession is similar to the way you post attendance for your class(es) during the regular school year. The differences are as follows:

- You need to choose the Intersession Track when you log in.
- All students are marked Absent by default.
- You need to take attendance for four periods per day.

How do I post attendance?

Enter your employee ID and Password.

Click Logon. A new window opens where you will need to select your I-Track.

Important: Choose your I-Track (Intersession) from the menu. You will see the Intersession track for the current school year as well as your other tracks when you log in. During Spring Intersession, you might see S tracks for next year.
2. Click the Attendance tab.

3. Select the first period of the Intersession course from the drop-down menu. (It may be helpful to click the By Period checkbox.) A class roster will appear. By default all students will be marked “Unverified Absence.”

<table>
<thead>
<tr>
<th>#</th>
<th>Student Name</th>
<th>ID</th>
<th>Apply Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AVALOS, VALERIE</td>
<td>042386600</td>
<td>Unverified Absence</td>
</tr>
<tr>
<td>2</td>
<td>DELGADO, DIANA</td>
<td>052565201</td>
<td>Unverified Absence</td>
</tr>
<tr>
<td>3</td>
<td>HILL, NYESHA</td>
<td>060887493</td>
<td>Unverified Absence</td>
</tr>
<tr>
<td>4</td>
<td>LONG, JACKLYN</td>
<td>111385190</td>
<td>Unverified Absence</td>
</tr>
<tr>
<td>5</td>
<td>ROBINSON, NYDIA</td>
<td>090286421</td>
<td>Unverified Absence</td>
</tr>
</tbody>
</table>

By default, all students are marked absent.

4. Click Present from the list of codes on the left side of the screen.

5. Click the double-arrow Apply button next to any student that was present during that period. Even if the student was only present for one minute of that period, mark him or her Present. If you mistakenly mark a student Present and need to change it back, click Unverified Absence from the list of codes and apply that code. (Note: If you track tardies, you will need to record that for yourself on paper. The tardy code is not used for official Intersession Programs.)
6. When you have marked all students Present for this period, click Submit. The Attendance Taken checkbox will become checked to show that you have posted attendance for this period.

7. You must repeat this process for every period! It is your responsibility to post attendance for all periods per day by the end of the school day. You will not be able to enter yesterday’s attendance. You can only post attendance for today.

What if I can’t log in to TeacherConnection to post attendance?

If you cannot access TeacherConnection to post attendance, you will need to take attendance on the paper roster given to you by the office. You must submit it to the office at the end of each day.

1. The roster is printed for a date range of one week. It will list each student’s name with As (for Unverified Absence) for each period each day of the week.

2. Find the appropriate date column. It should match the date for which you are taking attendance.

3. Mark an X through each A, signifying that the student is Present for that period.

If a student is Present for all periods, he or she should have the corresponding number of Xs for that day. If a student is Absent for all periods, he or she should have no Xs. If a student is Present for only part of the day, the number of Xs should represent the number of periods he or she was there.

<table>
<thead>
<tr>
<th>#</th>
<th>Student Name</th>
<th>ID</th>
<th>Apply Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Benis, Elaine</td>
<td>090994557</td>
<td>Present</td>
</tr>
<tr>
<td>2</td>
<td>Costanza, George A</td>
<td>060494363</td>
<td>Present</td>
</tr>
<tr>
<td>3</td>
<td>Kramer, Cosmo</td>
<td>011294219</td>
<td>Unverified Absence</td>
</tr>
<tr>
<td>4</td>
<td>Seinfeld, Jerald</td>
<td>032294500</td>
<td>Present</td>
</tr>
</tbody>
</table>
When do I sign attendance verification reports?

At the end of every week of Intersession Programs, the office will print an attendance verification report for you to sign. A dot (.) signifies that a student was Present for that period, and an A signifies Absent. You need to verify that the attendance is accurate, then sign and date the report. Return the verification report to the office as soon as possible so it can be filed for audit purposes.

Important! If you took attendance on paper for the week because you could not access TeacherConnection, sign the roster that you have been using and submit it to the office. You do not need to sign a computer-generated roster as shown above.
Troubleshooting TeacherConnection Problems

If you are having trouble logging in to TeacherConnection, you can attempt to troubleshoot by asking the following:

- **Are you accessing the correct webpage?**
  The correct URL is https://dwa.sis.sandi.net/zangleconnect/.

- **Are you logging in correctly?**
  It may be possible that you are using the wrong password, wrong ID, or have CAPS LOCK on.

- **Is your computer hooked up correctly?**
  Check the connections to make sure that the computer is hooked up to connect to the network.

- **Are you trying to log in before your status record start date?**
  Ask the school’s Zangle Power User (in the office) to check your faculty status record start date.
  The start date determines as of which date you can access the Intersession track of TeacherConnection. If necessary, have the Power User change the date.

- **Are you trying to log in before the start date of your Intersession Programs?**
  If you can log in but do not see students and the date is prior to the first day of the Intersession Program, you need to set the date on the Attendance tab to the first day of the Intersession session.

- **Are you set up in the master schedule?**
  If you can log in but do not see students and you have changed the date to an Intersession Program date, ask the school’s Zangle Power User in the office to check that you have been assigned a section(s).
Class Rosters

You can print **Class Rosters** for just your Intersession classes. The class roster below shows the standard format, which includes student name, ID, gender, and grade. Other formats are available.

### Class Rosters - Effective: 10/27/2003

**Standley Middle School - Standley Extended Day 03/04**

Faculty: Lopez, Juan [990169]
Course: 9015-3  EDRP Literacy
Period 0, Room 320

<table>
<thead>
<tr>
<th>Student Name</th>
<th>Ident</th>
<th>Gn</th>
<th>Gr</th>
</tr>
</thead>
<tbody>
<tr>
<td>AGUNAGA, EDWIN</td>
<td>071292193</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>ANDRADE, ERIN ALEJANDRA</td>
<td>061692584</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>ARECHIGA, SIERRA</td>
<td>052302039</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>AVELINO, ABIGAIL ELISA</td>
<td>111492425</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>BROWN, REBECCA JADE</td>
<td>122891422</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>CARRILLO, JIMMY</td>
<td>091792141</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>CASTRO, ISAIAH</td>
<td>032992457</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>CERVANTES, SAVANNAH</td>
<td>042292397</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>CORDOBA, IVON</td>
<td>092392562</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>DIAZ, AUSENCIA GERONIMO</td>
<td>061692170</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>GOLDING, MARY JEANE</td>
<td>112991359</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>GONZALEZ, ALEXANDER NOLBERTO</td>
<td>070392151</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>GONZALEZ, MARIELA</td>
<td>112792121</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>LERMA, ASHLEY ARLENE</td>
<td>061391151</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>LIM, JERRY JONG-YUP</td>
<td>071892514</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>LOPEZ, LUHS</td>
<td>011592023</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>LOZANO, MILES</td>
<td>120991230</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>MALDONADO, BRENT ALEXANDER</td>
<td>100892227</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>MELGDZA, JOHNNY</td>
<td>101192041</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>NARANJO, GREGORY ALBERTO</td>
<td>102992093</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>PADILLA, SANDRA</td>
<td>100792206</td>
<td>F</td>
<td>5</td>
</tr>
<tr>
<td>Park, PATRICK Janghoon</td>
<td>011593623</td>
<td>M</td>
<td>5</td>
</tr>
<tr>
<td>RAMIREZ, TRAVIS ANTONIO</td>
<td>112492119</td>
<td>M</td>
<td>5</td>
</tr>
</tbody>
</table>

Students in Class: 23
Schedule Listing

To print a student’s schedule, use the Schedule Listing report. It displays a student’s Intersession schedule only. See page 43 for directions.

<table>
<thead>
<tr>
<th>Student</th>
<th>ID</th>
<th>Grade</th>
<th>Gender</th>
<th>Track</th>
<th>Adviser</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELLSBURY, OWEN</td>
<td>011988871</td>
<td>10</td>
<td>M</td>
<td>E</td>
<td>Unassigned</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Course-Sec</th>
<th>Course Title</th>
<th>Period</th>
<th>Term</th>
<th>Room</th>
<th>Teacher</th>
</tr>
</thead>
<tbody>
<tr>
<td>1542-1</td>
<td>ENGLISH 1 (P)</td>
<td>7</td>
<td>EX1</td>
<td>100</td>
<td>Estavez</td>
</tr>
<tr>
<td>1542-1</td>
<td>ENGLISH 1 (P)</td>
<td>6</td>
<td>EX1</td>
<td>100</td>
<td>Estavez</td>
</tr>
<tr>
<td>1542-1</td>
<td>ENGLISH 1 (P)</td>
<td>9</td>
<td>EX1</td>
<td>100</td>
<td>Estavez</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Lockers:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
ATTENTION!

***Do Not Use***
Substitute Roster button during Intersession
or any other hourly program

See page 56 for directions on printing the correct roster for visiting teachers or any other teacher that cannot access TeacherConnection during Intersession.